HP ENVY 5530 e-All-in-One series
# Table of contents

1 HP ENVY 5530 e-All-in-One series Help ................................................................................................................................. 1

2 Get to know the HP ENVY 5530 series ................................................................................................................................. 3
   Printer parts .................................................................................................................................................. 4
   Control panel and status lights ....................................................................................................................... 6
   Auto-Off .................................................................................................................................................... 8

3 Print .................................................................................................................................................................................... 9
   Print photos ............................................................................................................................................... 10
   Print documents ......................................................................................................................................... 12
   Print envelopes ......................................................................................................................................... 14
   Print Quick Forms ........................................................................................................................................ 15
   Print with HP wireless direct ...................................................................................................................... 16
   Tips for print success ................................................................................................................................ 18
   Print using the maximum dpi ...................................................................................................................... 20

4 Paper basics ......................................................................................................................................................... 21
   Recommended papers for printing ............................................................................................................. 22
   Load media .............................................................................................................................................. 24
   Order HP Paper Supplies ........................................................................................................................ 28

5 Use Web Services .................................................................................................................................................... 29
   ePrint from anywhere ............................................................................................................................... 30
   Use HP Print Apps ................................................................................................................................ 32
   Use the HP Connected website .............................................................................................................. 33
   Tips for using Web Services .................................................................................................................... 34

6 Copy and scan .................................................................................................................................................. 35
   Copy documents ...................................................................................................................................... 36
   Scan to a computer or memory card ......................................................................................................... 39
   Tips for copy and scan success ................................................................................................................ 41
Learn how to use your HP ENVY 5530 series

- Get to know the HP ENVY 5530 series on page 3
- Print on page 9
- Use Web Services on page 29
- Copy and scan on page 35
- Work with cartridges on page 43
- Connectivity on page 53
- Technical information on page 87
- Solve a problem on page 63
2 Get to know the HP ENVY 5530 series

- Printer parts
- Control panel and status lights
- Auto-Off
**Printer parts**

*Figure 2-1  Front and top views of HP ENVY 5530 e-All-in-One series*

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Lid</td>
</tr>
<tr>
<td>2</td>
<td>Lid-backing</td>
</tr>
<tr>
<td>3</td>
<td>Glass</td>
</tr>
<tr>
<td>4</td>
<td>Paper-width guide</td>
</tr>
<tr>
<td>5</td>
<td>Cartridge access door</td>
</tr>
<tr>
<td>6</td>
<td>Paper path cover</td>
</tr>
<tr>
<td>7</td>
<td>Cartridge access area</td>
</tr>
<tr>
<td>8</td>
<td>Ink cartridges</td>
</tr>
<tr>
<td>9</td>
<td>On button</td>
</tr>
<tr>
<td>10</td>
<td>Memory card light</td>
</tr>
<tr>
<td>11</td>
<td>Memory card slot</td>
</tr>
<tr>
<td>12</td>
<td>Control panel</td>
</tr>
<tr>
<td>13</td>
<td>Color graphics display (also referred to as the display)</td>
</tr>
<tr>
<td>14</td>
<td>Paper tray</td>
</tr>
<tr>
<td>15</td>
<td>Paper tray extender (also referred to as the tray extender)</td>
</tr>
<tr>
<td>16</td>
<td>Model number location</td>
</tr>
<tr>
<td>17</td>
<td>Wireless status light and button</td>
</tr>
<tr>
<td>18</td>
<td>ePrint status light and button</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>19</td>
<td>Power connection. Use only the power cord supplied by HP.</td>
</tr>
<tr>
<td>20</td>
<td>Rear USB port</td>
</tr>
</tbody>
</table>
Control panel and status lights

Touch the directional buttons to navigate between two Home screens.

Figure 2-3 Control panel features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Home: Returns to the Home screen, the screen that is displayed when you first turn on the printer.</td>
</tr>
<tr>
<td>2</td>
<td>ePrint icon: Opens the <strong>Web Services Summary</strong> menu, where you can check ePrint status details, change ePrint settings, or print an Info page.</td>
</tr>
<tr>
<td>3</td>
<td>Wireless icon: Opens the <strong>Wireless Summary</strong> menu, where you can check wireless status and change wireless settings. You can also print a wireless test report, helping diagnose network connection issues.</td>
</tr>
<tr>
<td>4</td>
<td>Ink icon: Shows estimated ink levels by cartridge. Displays a warning symbol if the ink level is less than the minimum expected ink level.</td>
</tr>
<tr>
<td>5</td>
<td>Settings icon: Opens the <strong>Settings</strong> menu where you can change preferences and use tools to perform maintenance functions.</td>
</tr>
<tr>
<td>6</td>
<td>Wireless direct icon: From the wireless direct menu you will be able to turn wireless direct ON (with and without security), turn wireless direct OFF and display the wireless direct name and password if turned on with security.</td>
</tr>
<tr>
<td>7</td>
<td>Help: On the Home screen, shows all Help topics. On another screen, shows information or animation on the display to assist in the current operation.</td>
</tr>
<tr>
<td>8</td>
<td>Wireless status light: Indicates whether the printer has a wireless connection to the network.</td>
</tr>
<tr>
<td>9</td>
<td>Wireless button: Opens the <strong>Wireless Summary</strong> menu.</td>
</tr>
<tr>
<td>10</td>
<td>Directional buttons: Allow you to navigate through two home screens, photos, print previews, apps, and horizontal menu options.</td>
</tr>
<tr>
<td>11</td>
<td>Back: Returns to the previous screen.</td>
</tr>
<tr>
<td>12</td>
<td>Photo: Opens the <strong>Photo</strong> Menu where you can view and print photos, or reprint a printed photo.</td>
</tr>
<tr>
<td>13</td>
<td>Apps: Provides a quick and easy way to access and print information from the web, such as coupons, coloring pages, puzzles, and more.</td>
</tr>
<tr>
<td>14</td>
<td>Copy: Opens the <strong>Copy</strong> menu where you can select a copy type or change the copy settings.</td>
</tr>
<tr>
<td>15</td>
<td>Cancel: Stops the current operation.</td>
</tr>
<tr>
<td>16</td>
<td>ePrint button: Opens the <strong>Web Services Summary</strong> menu, where you can check ePrint status details, change ePrint settings, or print an Info page.</td>
</tr>
</tbody>
</table>
Feature Description

17 Scan: Opens the Scan menu where you can select a destination for your scan.

18 Quick Forms: Using HP Quick Forms, you can print calendars, check lists, games, notebook paper, graph paper, and music paper.

**Figure 2-4  Wireless status light and button**

1 Wireless status light
- Solid blue light indicates that wireless connection has been established and you can print.
- Slow blinking light indicates that wireless is on, but the printer is not connected to a network. Make sure your printer is within the range of wireless signal.
- Fast blinking light indicates wireless error. Refer to the message on the printer display.
- If wireless is turned off the wireless light is off, the display screen shows **Wireless Off**.

2 Wireless button
Press the button to display wireless status, IP address, network name, hardware address (MAC), and wireless direct status.

**Figure 2-5  ePrint button**

Press the button to display the printer’s email address, **ePrint** status, and **ePrint** feature.
Auto-Off

Auto-Off is automatically enabled in some regions by default when you turn on the printer. When Auto-Off is enabled, the printer automatically turns off after 2 hours of inactivity to help reduce energy use. **Auto-Off turns the printer off completely, so you must use the power button to turn the printer back on.** For printer models with wireless or Ethernet network capability, Auto-Off is automatically disabled when the printer establishes a wireless or Ethernet network connection. Even when Auto-Off is disabled, the printer enters Sleep mode after 5 minutes of inactivity to help reduce energy use.

To change the Auto-Off setting

1. Depending on your operating system, do one of the following to open the printer software:
   - **Windows 8:** On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer's name.
   - **Windows 7, Windows Vista,** and **Windows XP:** From the computer desktop, click Start, select All Programs, click HP, click HP ENVY 5530 series, and then click HP ENVY 5530 series.

2. In the printer software, select Print & Scan and then click Maintain Your Printer to access the printer toolbox.

3. In the printer toolbox that appears, click Advanced Settings, and then follow the onscreen instructions.

   Once you change the setting, the printer maintains the setting that you choose.
3 Print

- Print photos
- Print documents
- Print envelopes
- Print Quick Forms
- Print with HP wireless direct
- Tips for print success
- Print using the maximum dpi
Print photos

Load photo paper

1. Load photo paper into the paper tray.
   - Pull out the paper tray until it stops.
   - Load photo paper print side down.

   ● Move the paper-width guides inward against the edge of the paper.
   ● Push the paper tray in until it stops.

2. Open the paper tray extender.

Print photos from a memory card

1. Insert a memory card into the memory card slot.

2. From the Home screen, touch Photo to display the Photo menu.

3. On the Photo menu, touch View & Print to display photos.

4. Touch a photo that you want to print.

5. Touch the up or down arrow to specify the number of photos to print.

6. Touch Edit to select options to edit the selected photos. You can rotate, crop a photo, or turn Photo Fix on and off.

7. Touch Done and preview the selected photo. If you wish to adjust layout, paper type, red eye removal, or date stamp, touch Settings, and then touch your selection. You can also save any new settings as defaults.

8. Touch Print to begin printing.
To print a photo on photo paper

1. On the File menu in your software, click Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

   ● On the Layout tab, select Portrait or Landscape orientation.

   ● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the Tray Selection area, and then select the appropriate print quality in the Quality Settings area.

   ● Click Advanced to select the appropriate paper size from the Paper Size drop-down list.

   **NOTE:** For maximum dpi resolution, go to Paper/Quality tab, select Photo Paper from the Media drop-down list, and then select Best in the Quality Settings area. Then click the Advanced button and select Yes from the Print in Max DPI drop-down list. If you want to print max DPI in grayscale, select High Quality Grayscale from the Print in Grayscale drop-down list.

5. Click OK to return to the Properties dialog box.

6. Click OK, and then click Print or OK in the Print dialog box.

   **NOTE:** Do not leave unused photo paper in the paper tray. The paper might start to curl, which could reduce the quality of your printout. Photo paper should be flat before printing.
Print documents

Load paper

1. Load paper into the paper tray.
   - Pull out the paper tray until it stops.
   - Load paper print side down.
   - Move the paper-width guides inward against the edge of the paper.
   - Push the paper tray in until it stops.

2. Open the paper tray extender.

To print a document

1. From your software, click the Print button.
2. Make sure your printer is selected.
3. Click the button that opens the Properties dialog box.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences.
4. Select the appropriate options.
   - On the Layout tab, select Portrait or Landscape orientation.
   - On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the Tray Selection area, and then select the appropriate print quality in the Quality Settings area.
   - Click Advanced to select the appropriate paper size from the Paper Size drop-down list.
5. Click OK to close the Properties dialog box.
6. Click Print or OK to begin printing.

To print on both sides of the page

1. From your software, click the Print button.
2. Make sure your printer is selected.
3. Click the button that opens the **Properties** dialog box.

   Depending on your software application, this button might be called **Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences**.

4. Select the appropriate options.

   - On the **Layout** tab, select **Portrait** or **Landscape** orientation.
   - On the **Paper/Quality** tab, select the appropriate paper type and print quality from the **Media** drop-down list.
   - Click **Advanced** to select the appropriate paper size from the **Paper Size** drop-down list.

5. On the **Layout** tab, select **Flip on Long Edge** or **Flip on Short Edge** from the **Print on Both Sides** drop-down list.

6. Click **OK** to print.

   **NOTE:** After one page of the document has been printed, you will be prompted to wait for a few seconds. Then the printer will automatically load the paper back to print on the other side. You do not need to manually reload the paper or make any operations.

   **NOTE:** If your printed documents are not aligned within the margins of the paper, make sure that you have selected the correct language and region. On the printer display, select **Settings**, and then select **Preferences**. Select your language, and then region from the options provided. The correct language and country/region settings ensure that the printer will have the appropriate default paper size settings.
Print envelopes

You can load one or more envelopes into the paper tray of the HP ENVY 5530 series. Do not use shiny or embossed envelopes or envelopes that have clasps or windows.

**NOTE:** For specific details on how to format text for printing on envelopes, consult the help files in your word processing software. For best results, consider using a label for the return address on envelopes.

Load envelopes

1. Make sure the paper tray is open.
2. Slide the paper-width guides all the open.
3. Place the envelopes in the center of the paper tray. The side to be printed on should face down. The flap should be on the left side.
4. Push the envelopes into the printer until they stop.
5. Slide the paper-width guides firmly against the edge of the envelopes.

To print an envelope

1. On the File menu in your software, click Print.
2. Make sure your printer is selected.
3. Click the button that opens the Properties dialog box.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences.
4. Select the appropriate options.
   - On the Layout tab, select Portrait or Landscape orientation.
   - On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the Tray Selection area, and then select the appropriate print quality in the Quality Settings area.
   - Click Advanced to select the appropriate paper size from the Paper Size drop-down list.
5. Click OK, and then click Print or OK in the Print dialog box.
Print Quick Forms

Use HP Quick Forms to print fun and useful pages. You can print calendars, check lists, games, notebook paper, graph paper, and music paper.

To print Quick Forms

1. On the Home screen from your printer display, touch the right directional button, and then touch Quick Forms.

2. Touch Quick Forms. If you cannot find it, touch the right directional button to scroll through all the apps.

3. Select one of the HP Quick Form options: Calendar, Check List, Games, Notebook Paper, Graph Paper, and Music Paper.

4. Touch one of the subcategories from your selection. Use the right directional button to scroll through the subcategories.

5. Touch the left or right arrow button to specify the number of copies you want to print, and then touch Done.
Print with HP wireless direct

With HP wireless direct, you can print wirelessly from a computer, smart phone, tablet, or other wireless-capable device—without connecting to an existing wireless network.

When using HP wireless direct, note the following guidelines:

- Make sure your computer or mobile device has the necessary software:
  - If you are using a computer, make sure you have installed the printer software provided with the printer.
- Make sure HP wireless direct is turned on in the printer and, if necessary, security is enabled. For more information, see [Connect wirelessly to the printer without a router on page 57](#).
- Up to five computers and mobile devices can use the same HP wireless direct connection.
- HP wireless direct can be used while the printer is also connected to a computer using USB cable or to a network using a wireless connection.
- HP wireless direct cannot be used to connect a computer, mobile device, or printer to the Internet.

Click here to go online for more information.

**NOTE:** At this time, these websites might not be available in all languages.

This section contains the following topics:

- Print from a wireless-capable mobile device
- Print from a wireless-capable computer

**Print from a wireless-capable mobile device**


1. Make sure you have turned on HP wireless direct on the printer. For more information, see [Connect wirelessly to the printer without a router on page 57](#).

2. Turn on the Wi-Fi connection on your mobile device. For more information, see the documentation provided with the mobile device.

**NOTE:** If your mobile device does not support Wi-Fi, you are not able to use HP wireless direct.

3. From the mobile device, connect to a new network. Use the process you normally use to connect to a new wireless network or hotspot. Choose the HP wireless direct name from the list.
of wireless networks shown such as HP-Print-**-ENVY-5530 (where ** are the unique characters to identify your printer).

If HP wireless direct is turned on with security, enter the password when prompted.

4. Print your document.

Print from a wireless-capable computer

1. Make sure you have turned on HP wireless direct on the printer. For more information, see Connect wirelessly to the printer without a router on page 57 for more information.

2. Turn on the computer’s Wi-Fi connection. For more information, see the documentation provided with the computer.

**NOTE:** If your computer does not support Wi-Fi, you are not able to use HP wireless direct.

3. From the computer, connect to a new network. Use the process you normally use to connect to a new wireless network or hotspot. Choose the HP wireless direct name from the list of wireless networks shown such as HP-Print-**-ENVY-5530 (where ** are the unique characters to identify your printer).

If HP wireless direct is turned on with security, enter the password when prompted.

4. Proceed to step 5 if the printer has been installed and connected to the computer over a wireless network. If the printer has been installed and connected to your computer with a USB cable, follow the steps below to install the printer software using the HP wireless direct connection.

   a. Depending on your operating system, do one of the following:
      
      - **Windows 8:** On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click Printer Setup & Software.
      - **Windows 7, Windows Vista,** and **Windows XP:** From the computer desktop, click Start, select All Programs, click HP, click HP ENVY 5530 series, and then click Printer Setup & Software.

   b. Select Connect New Printer.

   c. When the Connection Options software screen appears, select Wireless.

      Select HP ENVY 5530 series from the list of detected printers.

   d. Follow the on-screen instructions.

5. Print your document.
Tips for print success

Use the following tips to print successfully.

Tips for printing from a computer

For more information on printing documents, photos, or envelopes from a computer, use the following links to operating-system specific instructions.

- Learn how to print photos saved on your computer. Learn how to enable maximum dpi resolution. [Click here to go online for more information.]
- Learn how to print envelopes from your computer. [Click here to go online for more information.]

Tips for ink and paper

- Use original HP cartridges. Original HP cartridges are designed for and tested with HP printers to help you produce great results, time after time.
- Make sure the cartridges have sufficient ink. To view the estimated ink levels, touch the Ink icon from the Home screen.

To learn more tips about working with cartridges, see [Tips for working with cartridges on page 51] for more information.

- Load a stack of paper, not just one page. Use clean and flat paper of the same size. Make sure only one type of paper is loaded at a time.
- Adjust the paper-width guides in the paper tray to fit snugly against all paper. Make sure the paper-width guides do not bend the paper in the paper tray.
- Set the print quality and paper size settings according to the type and size of paper loaded in the paper tray.
- To clear paper jam, see [Clear paper jam on page 64] for more information.

Printer settings tips

- On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the Tray Selection area, and then select the appropriate print quality in the Quality Settings area.

- Select the appropriate paper size from the Paper Size drop-down list in the Advanced Options dialog box. Access the Advanced Options dialog box by clicking the Advanced button on the Layout or Paper/Quality tab.

- To change default print settings, click Print & Scan, and then click Set Preferences in the printer software.

Depending on your operating system, do one of the following to open the printer software:

- **Windows 8**: On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer's name.

- **Windows 7, Windows Vista, and Windows XP**: From the computer desktop, click Start, select All Programs, click HP, click HP ENVY 5530 series, and then click HP ENVY 5530 series.

- If you want to print a black and white document using black ink only, click the Advanced button. From the Print in Grayscale drop-down menu, select Black Ink Only, then click the OK button.
Notes

• Original HP ink cartridges are designed and tested with HP printers and papers to help you easily produce great results, time after time.

  **NOTE:** HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs required as a result of using a non-HP supply will not be covered under warranty.

  If you believe you purchased original HP ink cartridges, go to:

  [www.hp.com/go/anticounterfeit](http://www.hp.com/go/anticounterfeit)

• Ink level warnings and indicators provide estimates for planning purposes only.

  **NOTE:** When you receive a low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do not need to replace the cartridges until print quality becomes unacceptable.

• Software settings selected in the print driver only apply to printing, they do not apply to copying or scanning.

• You can print your document on both sides of the paper.
Print using the maximum dpi

Use maximum dots per inch (dpi) mode to print high-quality, sharp images on photo paper.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of disk space.

To print in Maximum dpi mode

1. On the File menu in your software, click Print.
2. Make sure your printer is selected.
3. Click the button that opens the Properties dialog box.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer Properties, Printer, or Preferences.
4. Click the Paper/Quality tab.
5. From the Media drop-down list, select the appropriate paper type and print quality.
6. Click the Advanced button.
7. In the Printer Features area, select Yes from the Print in Max DPI drop-down list.
8. Select the appropriate paper size from the Paper Size drop-down list.
9. Click OK to close the advanced options.
10. Confirm Orientation on the Layout tab, and then click OK to print.
4 Paper basics

- Recommended papers for printing
- Load media
- Order HP Paper Supplies
Recommended papers for printing

If you want the best print quality, HP recommends using HP papers that are specifically designed for the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

**ColorLok**

- HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, and dry faster than ordinary plain papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

**Photo printing**

- **HP Premium Plus Photo Paper**
  
  HP Premium Plus Photo Paper is HP’s highest-quality photo paper for your best photos. With HP Premium Plus Photo Paper, you can print beautiful photos that are instant-dry so you can share them right off the printer. It is available in several sizes, including A4, 8.5 x 11 inch, 4 x 6 inch (10 x 15 cm), 5 x 7 inch (13 x 18 cm), and 11 x 17 inch (A3), and in two finishes - glossy or soft gloss (semi-gloss). Ideal for framing, displaying, or gifting your best photos and special photo projects. HP Premium Plus Photo Paper delivers exceptional results with professional quality and durability.

- **HP Advanced Photo Paper**
  
  This thick photo paper features an instant-dry finish for easy handling without smudging. It resists water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-processed photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm (4 x 6 inch), 13 x 18 cm (5 x 7 inch). It is acid-free for longer lasting documents.

- **HP Everyday Photo Paper**
  
  Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper with any inkjet printer. It is available in glossy finish in several sizes, including A4, 8.5 x 11 inch, and 10 x 15 cm (4 x 6 inch). For longer-lasting photos, it is acid-free.

**Business documents**

- **HP Premium Presentation Paper** or **HP Professional Paper 120**
  
  These papers are heavy two-sided matte papers perfect for presentation, proposals, reports, and newsletters. They are heavyweight for an impressive look and feel.

- **HP Brochure Paper** or **HP Professional Paper 180**
These papers are glossy-coated or matte-coated on both sides for two-sided use. They are the perfect choice for near-photographic reproductions and business graphics for report covers, special presentations, brochures, mailers, and calendars.

**Everyday printing**

- **HP Bright White Inkjet Paper**
  HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors.

- **HP Printing Paper**
  HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more substantial than documents printed on standard multipurpose or copy paper. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

- **HP Office Paper**
  HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other everyday documents. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

- **HP Office Recycled Paper**
  HP Office Recycled Paper is a high-quality multifunction paper made with 30% recycled fiber. It features ColorLok Technology for less smearing, bolder blacks and vivid colors.

**Special projects**

- **HP Iron-On Transfers**
  HP Iron-on Transfers (for light or white fabrics) are the ideal solution for creating custom T-shirts from your digital photos.
Load media

Do one of the following:

Load small-size paper

1. Pull out the paper tray, slide the paper-width guides outward, and then remove any previously loaded media.

2. Load paper.
   - Insert a stack of photo paper into the paper tray with the short edge forward and the print side down.
   - Slide the photo paper forward until it stops.
● Slide the paper-width guides inward until they stop at the edges of the paper.

● Push the paper tray back in, and then open the paper tray extender.

**Load full-size paper**

1. Pull out the paper tray, slide the paper-width guides outward, and then remove any previously loaded media.

2. Load paper.
   - Insert a stack of paper into the paper tray with the short edge forward and the print side down.
● Slide the paper forward until it stops.
● Slide the paper-width guides inward until they stop at the edges of the paper.

● Push the paper tray back in, and then open the paper tray extender.

**Load envelopes**

1. Pull out the paper tray, slide the paper-width guides outward, and then remove any previously loaded media.
2. Load envelopes

- Insert one or more envelopes in the center of the paper tray. The print side should face down. The flap should be on the left side and facing up.

- Slide a stack of envelopes inward until it stops.
- Slide the paper-width guides inward against the stack of envelopes until they stop.
- Push the paper tray back in, and then open the paper tray extender.
Order HP Paper Supplies

The printer is designed to work well with most types of office media. Use HP media for optimum print quality. Visit the HP website at www.hp.com for more information about HP media.

HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks and dry faster than ordinary plain papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

To purchase HP papers, go to Shop for Products and Services and select ink, toner and paper.
5 Use Web Services

- ePrint from anywhere
- Use HP Print Apps
- Use the HP Connected website
- Tips for using Web Services
ePrint from anywhere

HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled printer anywhere you can send an email. Just send your documents and photos to the email address assigned to your printer when you enable Web Services. No additional drivers or software are needed.

- Your printer needs to have a wireless network connection to the Internet. You won't be able to use HP ePrint via a USB connection to a computer.
- Attachments might print differently from the way they appear in the software program that created them, depending on the original fonts and layout options used.
- Free product updates are provided with HP ePrint. Some updates might be required to enable certain functionality.

Once you have signed up for an account on HP Connected(www.hpconnected.com), you can sign in to view your ePrint job status, manage your ePrint printer queue, control who can use your printer’s ePrint email address to print, and get help for ePrint.

Before you can use ePrint, make sure that:

- The printer is connected to an active network providing Internet access.
- Web Services is turned on. If not, you will be prompted to turn it on.

To ePrint a document from anywhere

1. Enable Web Services.
   a. From the printer control panel, press the ePrint button.
   b. Accept the Terms of Use, and then follow the onscreen instructions to enable Web Services.
   c. Print the ePrint information page, and then follow the instructions on the page to sign up for an ePrint account.

2. Find your ePrint email address.
   a. Press the ePrint button on the control panel. You will see the Web Services Settings menu on the printer display.
   b. The printer’s email address appears in the Web Services Settings menu.

   **TIP:** To print the email address or registration url, select Print Info Page from the Settings menu on the printer display.

3. Email your document to the printer for printing.
   a. Create a new email and attach the document to print.
   b. Send the email to the printer email address.

   The printer prints the attached document.

   **NOTE:** The ePrint server does not accept email print jobs if there are multiple email addresses included in the “To” or “Cc” fields. Only enter the HP ePrint email address in the “To” field. Do not enter any additional email addresses in the other fields.
NOTE: The email will be printed once it is received. As with any email, there is no guarantee when or whether it will be received. You can check the print status on HP Connected (www.hpconnected.com).

NOTE: Documents printed with ePrint may appear different from the original. Style, formatting, and text flow may differ from the original document. For documents that need to be printed with a higher quality (such as legal documents), we recommend that you print from the software application on your computer, where you will have more control over what your printout looks like.

Click here to go online for more information.
Use HP Print Apps

Print pages from the web, without using a computer, by setting up Apps, a free service from HP. You can print coloring pages, calendars, puzzles, recipes, maps, and more, depending on the apps available in your country/region.

Touch the Get More icon on the Apps screen to connect to the Internet and add more apps. You need to have Web Services enabled in order to use apps.

Go to the HP Connected website for more information and specific terms and conditions: www.hpconnected.com.
Use the HP Connected website

Use HP’s free HP Connected website to set up increased security for HP ePrint, and specify the email addresses that are allowed to send email to your printer. You can also get product updates, more apps, and other free services.

Go to the HP Connected website for more information and specific terms and conditions: www.hpconnected.com.
Tips for using Web Services

Use the following tips to print apps and use HP ePrint.

Tips for printing apps and using HP ePrint

- Learn how to share your photos online and order prints. Click here to go online for more information.
- Learn about apps for printing recipes, coupons, and other content from the web, simply and easily. Click here to go online for more information.
- If you have enabled Auto-Off, you should disable Auto-Off to use ePrint. See Auto-Off on page 8 for more information.
6 Copy and scan

- Copy documents
- Scan to a computer or memory card
- Tips for copy and scan success
Copy documents

The Copy menu on the printer display allows you to easily select number of copies and color or black and white for copying on plain paper. You can also easily access advanced settings, such as changing the paper type and size, adjusting the darkness of the copy, and resizing the copy.

Make a 1-sided copy

1. Load full-size paper in the paper tray.

- Make sure the paper tray is pushed back in and the paper tray extender is open.

2. Lift the lid on the product.

- Tip: To make copies of thick originals, such as books, you can remove the lid.

3. Load the original print side down on the right front corner of the glass.

4. Close the lid.
5. Specify number of copies and settings.
   - From the Home screen, touch Copy. Touch arrow buttons to change the number of copies.
   - If the 2–Sided option is selected, touch it to clear the selection.
   - Touch Settings to specify paper size, paper type, quality, or other settings.

   - Touch Black or Color.

**Make a 2-sided copy**

1. Load full-size paper in the paper tray.

   ![Image of a printer with paper loaded]

   - Make sure the paper tray is pushed back in and the paper tray extender is open.

2. Lift the lid on the product.

   ![Image of a printer with the lid open]

**TIP:** To make copies of thick originals, such as books, you can remove the lid.
3. Load the original print side down on the right front corner of the glass.

4. Close the lid.

5. Select **Copy**.
   - From the Home screen, touch **Copy**. Touch arrow buttons to change the number of copies.
   - If the **2-Sided** option is not selected, touch to select the option.
   - Touch **Settings** to specify paper size, paper type, quality, or other settings.

   - Touch **Black** or **Color**.
   - When prompted on the printer display, load the second original onto glass and touch **OK**.
Scan to a computer or memory card

You can scan to a computer either from the printer display or from the printer software on your computer. Scanning from the printer display is quick. Scanning from the software gives you more options.

Before you can scan to a computer from the printer display, make sure the printer is connected to your computer either on a wireless network or through a USB cable.

Prepare the scan

1. Lift the lid on the product.

2. Load the original print side down on the right front corner of the glass.

3. Close the lid.

Scan to a computer or memory card from the printer display

1. Load the original.

2. To scan to a memory card, insert a memory card in the memory card slot.
   
   If you want to scan to a computer, make sure the printer is connected to your computer on a wireless network or through a USB cable.

3. Start scan.
a. From the Home screen, touch the right directional button, and then touch **Scan**.

b. Select the destination by touching either **Computer** or **Memory Card**.

   Touch **Touch here to preview** to preview the scan.

   Touch **Settings** to select a scan type or change resolution.

c. Touch **Scan**.

### Scan from your computer

1. Depending on your operating system, do one of the following to open the printer software.
   - **Windows 8**: On the **Start** screen, right-click an empty area on the screen, click **All Apps** on the app bar, and then click the icon with the printer's name.
   - **Windows 7, Windows Vista**, and **Windows XP**: From the computer desktop, click **Start**, select **All Programs**, click **HP**, click **HP ENVY 5530 series**, and then click **HP ENVY 5530 series**.

2. In the printer software, click the **Print & Scan** icon, and then select **Scan a Document or Photo**.

3. Select the type of scan that you want from the shortcut menu and then click **Scan**.

   **NOTE**: If **Show Scan Preview** is selected, you will be able to make adjustments to the scanned image in the preview screen.

4. Select **Save** if you want to keep the application open for another scan, or select **Done** to exit the application.

5. After the scan is saved, a Windows Explorer window will open in the directory where the scan was saved.

   **NOTE**: There is a limited number of computers that can have the scan function activated at the same time. Select **Scan** on the printer display and you will see the computers that are currently available for scanning.
Tips for copy and scan success

Use the following tips to copy and scan successfully:

● Learn how to scan to email from the printer display. Click here to go online for more information.

● Keep the glass and the back of the lid clean. The scanner interprets anything it detects on the glass as part of the image.

● Load your original, print side down, on the right front corner of the glass.

● To make a large copy of a small original, scan the original into the computer, resize the image in the scanning software, and then print a copy of the enlarged image.

● If you want to adjust scan size, output type, scan resolution, or file type, and so on, start scan from the printer software.

● To avoid incorrect or missing scanned text, make sure the brightness is set appropriately in the software.

● If you have a wireless connection and you have confirmed that the connection is working, you will need to enable wireless scanning in the software to scan from the printer display. Open the printer software to select Print & Scan and then select Manage Scan to Computer.

● If you have a wireless connection from your printer to your computer, and you want to always be able to quickly scan to your connected computer, choose to have Scan to Computer always active.

● If you want to scan a document with several pages into one file instead of multiple files, start the scan with the printer software instead of selecting Scan from the printer display.
7 Work with cartridges

- Check the estimated ink levels
- Order ink supplies
- Replace the cartridges
- Use single-cartridge mode
- Cartridge warranty information
- Tips for working with cartridges
Check the estimated ink levels

To check the ink levels from the control panel

- From the Home screen, touch the Ink icon to display the estimated ink levels.

To check the ink levels from the printer software

1. Double-click the HP ENVY 5530 series desktop icon to open the printer software.
   
   **NOTE:** You can also access the printer software by clicking Start > All Programs > HP > HP ENVY 5530 series >HP ENVY 5530 series

2. In the printer software, click Estimated Ink Levels.

   **NOTE:** If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in another printer, the ink level indicator might be inaccurate or unavailable.

   **NOTE:** Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do not have to replace the cartridges until the print quality is unacceptable.

   **NOTE:** Ink from the cartridges is used in the printing process in a number of different ways, including in the initialization process, which prepares the product and cartridges for printing, and in printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it is used. For more information, see [www.hp.com/go/inkusage](http://www.hp.com/go/inkusage).
Order ink supplies

Before ordering cartridges, locate the correct cartridge number.

Locate the cartridge number on the printer

- The cartridge number is located inside the cartridge access door.

Locate the cartridge number in the printer software

1. Depending on your operating system, do one of the following to open the printer software:
   - Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer’s name.
   - Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All Programs, click HP, click HP ENVY 5530 series, and then click HP ENVY 5530 series.

2. In the printer software, click Shop, and then click Shop For Supplies Online.
   The correct cartridge number appears when you use this link.

To order original HP supplies for the HP ENVY 5530 series, go to www.hp.com/buy/supplies. If prompted, choose your country/region, follow the prompts to select your product, and then click one of the shopping links on the page.

NOTE: Ordering ink cartridges online is not supported in all countries/regions. If it is not available in your country/region, you may still view supplies information and print a list for reference when shopping at a local HP reseller.
Replace the cartridges

To replace the cartridges

1. Check that power is on.
2. Remove the old cartridge.
   a. Open the access door.
   b. Lift up the lid on the print cartridge, then remove the cartridge from the slot.
3. Insert a new cartridge.
   a. Remove the cartridge from packaging.
b. Remove plastic tape using the pink pull tab.

c. Slide the new cartridge in the slot at an angle under the opened lid, and then squeeze the lid closed as the cartridge slides into place.

```
```

d. Close access door.

```
```

4. Close the cartridge access door.

```

NOTE: The HP printer software prompts you to align the ink cartridges when you print a document after installing a new ink cartridge.

Related topics

- Order ink supplies on page 45
Tips for working with cartridges on page 51
Use single-cartridge mode

Use the single-cartridge mode to operate the HP ENVY 5530 series with only one ink cartridge. The single-cartridge mode is initiated when an ink cartridge is removed from the ink cartridge carriage. During single-cartridge mode, the printer can copy documents, copy photos, and print jobs from the computer.

NOTE: When the HP ENVY 5530 series operates in single-cartridge mode, a message is displayed on the printer display. If the message is displayed and two ink cartridges are installed in the printer, verify that the protective piece of plastic tape has been removed from each ink cartridge. When plastic tape covers the ink cartridge contacts, the printer cannot detect that the ink cartridge is installed.

Exit single-cartridge mode

- Install two ink cartridges in the HP ENVY 5530 series to exit single-cartridge mode.
Cartridge warranty information

The HP cartridge warranty is applicable when the cartridge is used in its designated HP printing device. This warranty does not cover HP ink cartridges that have been refilled, remanufactured, refurbished, misused, or tampered with.

During the warranty period the cartridge is covered as long as the HP ink is not depleted and the end of warranty date has not been reached. The end of warranty date, in YYYY/MM format, may be found on the cartridge as indicated:

For a copy of the HP Limited Warranty Statement for the printer, see the printed documentation that came with the product.
Tips for working with cartridges

Use the following tips to work with cartridges:

● To protect the cartridges from drying out, always turn the printer off using the On button, and wait until the On button light goes out.

● Do not open or untape cartridges until you are ready to install them. Leaving tape on the cartridges reduces ink evaporation.

● Insert the cartridges into the correct slots. Match the color and icon of each cartridge to the color and icon for each slot. Make sure the cartridges snap into place.

● After you insert new cartridges, align the printer for best print quality. See Improve print quality on page 70 for more information.

● When the Estimated Ink Levels screen shows one or both cartridges in a low state, consider getting replacement cartridges to avoid possible printing delays. You do not need to replace the cartridges until print quality becomes unacceptable. See Replace the cartridges on page 46 for more information.

● If you receive a carriage stalled error, try clearing carriage jam. See Clear carriage jam on page 68 for more information.

● If you remove a cartridge from the printer for any reason, try to replace it again as soon as possible. Outside of the printer, if unprotected, cartridges begin to dry out.
8 Connectivity

- Wi-Fi Protected Setup (WPS – requires WPS router)
- Traditional wireless connection (requires router)
- Connect wirelessly to the printer without a router
- Change from a USB connection to a wireless network
- Tips for setting up and using a networked printer
- Advanced printer management tools (for networked printers)
Wi-Fi Protected Setup (WPS – requires WPS router)

These instructions are for customers who have already setup and installed the printer software. For first time installation refer to the setup instructions that came with the printer.

To connect the HP ENVY 5530 series to a wireless network using Wi-Fi Protected Setup (WPS), you will need the following:

- A wireless 802.11b/g/n network that includes a WPS-enabled wireless router or access point.

  **NOTE:** The HP ENVY 5530 series only supports connections using 2.4GHz.

- A desktop computer or laptop with either wireless networking support, or a network interface card (NIC). The computer must be connected to the wireless network that you intend to install the HP ENVY 5530 series on.

  **NOTE:** If you have a Wi-Fi Protected Setup (WPS) router with a WPS push button, follow the Push Button method. If you are not certain your router has a push button, follow the Wireless Settings Menu method.

**Push Button (PBC) method**

1. Press and hold the **Wireless** button on the printer until the wireless light starts blinking, approximately three seconds to start WPS push button mode.

2. Press the Wi-Fi Protected Setup (WPS) button on your router.

   **NOTE:** The printer begins a timer for approximately two minutes while a wireless connection is established.

**PIN method**

1. Press the **Wireless** button on the printer control panel to display the Wireless menu. If the printer is printing, in an error state, or performing a critical task, wait until the task has been completed or the error cleared before pressing the **Wireless** button.

2. Select **Settings** from the printer display.

3. Select **Wi-Fi Protected Setup** from the printer display.

4. If you have a Wi-Fi Protected Setup (WPS) router with a WPS push button, select **Push Button**, and then follow the onscreen instructions. If your router does not have a push button or you are not certain if your router has a push button, select **PIN**, and then follow the onscreen instructions.

   **NOTE:** The printer begins a timer for approximately four minutes during which the corresponding button on the networking device needs to be pressed or the router PIN needs to be entered on the router’s configuration page.
Traditional wireless connection (requires router)

To connect the HP ENVY 5530 series to an integrated wireless WLAN 802.11 network, you will need the following:

- A wireless 802.11b/g/n network that includes a wireless router or access point.

 NOTE: 802.11n will only support 2.4Ghz.

- A desktop computer or laptop with either wireless networking support, or a network interface card (NIC). The computer must be connected to the wireless network that you intend to install the HP ENVY 5530 series on.

- Broadband Internet access (recommended) such as cable or DSL.

  If you connect the HP ENVY 5530 series on a wireless network that has Internet access, HP recommends that you use a wireless router (access point or base station) that uses Dynamic Host Configuration Protocol (DHCP).

- Network name (SSID).

- WEP key or WPA Passphrase (if needed).

To connect the product with the Wireless Setup Wizard

1. Write down your network name (SSID) and WEP key or WPA passphrase.


   a. From the Home screen, touch the Wireless icon, and then touch Settings.


3. Connect to wireless network.

   a. Select your network from the list of detected networks.

4. Follow prompts.

5. Install software.

Connect a new printer

If you have not connected the printer to your computer, or you want to connect another new printer of the same model to your computer, you can use the Connect a new printer function to set up the connection.

 NOTE: This method is available if you have already installed the printer software. It can be used if your printer had to be replaced as part of a service unit exchange.

1. Depending on your operating system, do one of the following to open the printer software.
- **Windows 8**: On the **Start** screen, right-click an empty area on the screen, click **All Apps** on the app bar, and then click the icon with the printer's name.

- **Windows 7, Windows Vista**, and **Windows XP**: From the computer desktop, click **Start**, select **All Programs**, click **HP**, click **HP ENVY 5530 series**, and then click **HP ENVY 5530 series**.

2. Select **Printer Setup & Software**.
3. Select **Connect a new printer**. Follow the on-screen instructions.

**Change network settings**

1. From the Home screen, touch the **Wireless** icon, and then touch **Settings**.
2. Touch **Advanced Settings**.
3. Select the item to be changed from the **Advanced Settings** menu.
4. Follow the onscreen instructions.
Connect wirelessly to the printer without a router

wireless direct allows your Wi-Fi devices (for example: computers or smartphones) to connect to your printer directly through Wi-Fi, using the process you currently use to connect your Wi-Fi device to new wireless networks and hotspots. You can print directly to the printer wirelessly with the wireless direct connection.

To connect wirelessly to the printer without a router

1. Turn on wireless direct from the control panel:
   a. From the Home screen, touch the Wireless Direct icon.
   b. If Wireless Direct displays Off, touch Settings.
   c. Touch Wireless Direct, touch On (No Security) or On (With Security).

   **NOTE:** If you turn on security, only users with the password will be able to print wirelessly to the printer. If you turn off security, anyone with a Wi-Fi device within Wi-Fi range of the printer will be able to connect to the printer.

2. Locate the wireless direct name and password if you have wireless direct security on:
   a. From the Home screen, touch the wireless direct icon.
   b. Touch Display Name to display the wireless direct name.
   c. Touch Display Password to display the wireless direct password.

3. From your wireless computer or mobile device, turn on the Wi-Fi connection, search for and connect to the wireless direct name, such as HP-Print-**-ENVY-5530 (where ** are the unique characters to identify your printer)

   If you have wireless direct security on, enter the wireless direct password when prompted.

4. Print a photo or a document as you normally do from your computer or mobile device.

   Click here to go online for more information.
Change from a USB connection to a wireless network

If you first setup your printer and installed the software with a USB cable, directly connecting the printer to your computer, you can easily change to a wireless network connection. You will need a wireless 802.11b/g/n network that includes a wireless router or access point.

**NOTE:** The HP ENVY 5530 series only supports connections using 2.4GHz.

Before changing from a USB connection to a wireless network, make sure that:

- The printer is connected to your computer with the USB cable until you are prompted to disconnect the cable.
- The computer is connected to the wireless network that you intend to install the printer on.

### Change from a USB connection to a wireless network

1. Depending on your operating system, do one of the following to open the printer software.
   - **Windows 8:** On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer's name.
   - **Windows 7, Windows Vista,** and **Windows XP:** From the computer desktop, click Start, select All Programs, click HP, and then click HP ENVY 5530 series.

2. Select **Printer Setup & Software.**

3. Select **Convert a USB connected printer to wireless.** Follow the on-screen instructions.
Tips for setting up and using a networked printer

Use the following tips to set up and use a networked printer:

- When setting up the wireless networked printer, make sure your wireless router is powered on. The printer searches for wireless routers, then lists the detected network names on the display.

  **NOTE:** If your printer has not been setup with a wireless connection, press the **Wireless** button on the printer to start the Wireless Setup Wizard.

- To check the wireless connection on the printer, touch the **Wireless** button on the control panel to open the Wireless Summary menu. If it shows **Wireless Off** or **Not Connected**, touch **Settings** and select **Wireless Setup Wizard**. Follow the on-screen instructions to set up your printer wireless connection.

- If your computer is connected to a Virtual Private Network (VPN), you need to disconnect from the VPN before you can access any other device on your network, including the printer.

- Learn more about configuring your network and the printer for wireless printing. **Click here to go online for more information.**

- Learn how to find your network security settings. **Click here to go online for more information.**

- Learn about the Network Diagnostic Utility (Windows only) and other troubleshooting tips. **Click here to go online for more information.**

- Learn how to change from a USB to wireless connection. **Click here to go online for more information.**

- Learn how to work with your firewall and anti-virus programs during printer setup. **Click here to go online for more information.**
Advanced printer management tools (for networked printers)

When the printer is connected to a network, you can use the embedded Web server to view status information, change settings, and manage the printer from your computer.

**NOTE:** To view or change some settings, you might need a password.

You can open and use the embedded Web server without being connected to the Internet. However, some features are not available.

- To open the embedded Web server
- About cookies

**To open the embedded Web server**

You can access the embedded Web server via either the network or Wireless Direct.

**Open the embedded Web server via network**

**NOTE:** The printer must be on a network and must have an IP address. The IP address for the printer can be found by pressing the Wireless button or by printing a network configuration page.

- In a supported Web browser on your computer, type the IP address or hostname that has been assigned to the printer.

For example, if the IP address is 192.168.0.12, type the following address into a Web browser: http://192.168.0.12.

**Open the embedded Web server via Wireless Direct**

1. From the home screen, press the Wireless button and then select Settings.
2. If the display shows that wireless direct is Off, select Wireless Direct and then select On (No Security) or On (With Security).
3. From your wireless computer, turn wireless on, search for and connect to the wireless direct name, for example: HP-Print-**-ENVY-5530 (where ** are the unique characters to identify your printer). If you have wireless direct security on, enter the wireless direct password when prompted.
4. In a supported Web browser on your computer, type the following address: http://192.168.223.1.

**About cookies**

The embedded Web server (EWS) places very small text files (cookies) on your hard drive when you are browsing. These files let the EWS recognize your computer the next time you visit. For example, if you have configured the EWS language, a cookie helps remember which language you have selected so that the next time you access the EWS, the pages are displayed in that language. Though some cookies are cleared at the end of each session (such as the cookie that stores the selected language), others (such as the cookie that stores customer-specific preferences) are stored on the computer until you clear them manually.

You can configure your browser to accept all cookies, or you can configure it to alert you every time a cookie is offered, which allows you to decide which cookies to accept or refuse. You can also use your browser to remove unwanted cookies.
NOTE: Depending on your printer, if you disable cookies, you also disable one or more of the following features:

- Starting where you left the application (especially useful when using setup wizards)
- Remembering the EWS browser language setting
- Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete cookies, see the documentation available with your Web browser.
Solve a problem

- Clear paper jam
- Clear carriage jam
- Clean ink smear
- Improve print quality
- Ink cartridge problem
- Unable to print
- Solve print problem
- Solve copy and scan problem
- Solve networking problem
- Cartridge errors (Windows software)
- HP support
Clear paper jam

Clear a paper jam from the paper path.

To clear a paper jam from the paper path

1. Open the cartridge access door.

2. Open the paper path cover.

3. Remove the jammed paper from the rear roller.

4. Close the paper path cover.
5. Close the cartridge access door.

6. Try printing again.

Clear a paper jam from the duplexer.

To clear a paper jam from the duplexer

1. Open the cartridge access door.

2. Open the paper path cover.

3. Press on the hole of the duplexer path cover to lift it up. Remove the jammed paper.
4. Close the paper path cover.

5. Close the cartridge access door.

6. Try printing again.

Clear a paper jam from the paper tray.

To clear a paper jam from the paper tray

1. Remove all paper or media from the paper tray.
2. Rotate printer until it rests on its left side.
3. Slide out the paper tray, and then remove jammed paper from inside the printer.
4. Slide the paper tray back into place.
5. Rotate the printer so it stands on its base, and then load the paper.

Clear a paper jam from the print zone.

To clear a paper jam from print zone

1. Open the cartridge access door.
2. Remove the jammed paper from inside the printer.

3. Close the cartridge access door.

4. Press the OK button on the control panel to continue the current job.

Prevent paper jams

- Do not overfill the paper tray.
- Remove printed papers from the paper tray frequently.
- Ensure that paper loaded in the paper tray lays flat and the edges are not bent or torn.
- Do not combine different paper types and paper sizes in the paper tray; the entire stack of paper in the paper tray must be the same size and type.
- Adjust the paper-width guides in the paper tray to fit snugly against all paper. Make sure the paper-width guides do not bend the paper in the paper tray.
- Do not force the paper too far forward in the paper tray.

If the above solutions do not resolve the problem, click here for more online troubleshooting.
Clear carriage jam

Remove any objects, such as paper, that are blocking the print carriage.

NOTE: Do not use any tools or other devices to remove jammed paper. Always use caution when removing jammed paper from inside the printer.

To get help from the print display, touch Help from the Home screen. Touch the directional button to navigate through help topics, touch Troubleshoot and Support, and then touch Clear Carriage Jam.

Click here to go online for more information.
Clean ink smear

If a printout shows smears of ink, for subsequent prints, try using the Clean Ink Smear function from the printer display. This process takes several minutes to complete. Full-size plain paper needs to be loaded and will be moved back and forth during the cleaning. Mechanical noises are normal at this time.

To clean ink smear from the printer display

1. From the Home screen, touch the Settings icon, and then touch Tools.
2. On the Tools menu, touch the down arrow to scroll through the options, and then touch Clean Ink Smear.
Improve print quality

NOTE: To avoid print quality problems, always turn the printer off using the On button, and wait until the On button light goes out before you pull the plug or turn off a power strip. This allows the printer to move the cartridges to a capped position, where they are protected from drying out.

To improve print quality

1. Make sure you are using original HP ink cartridges.

2. Check the printer software to make sure you have selected the appropriate paper type from the Media drop-down list and print quality from the Quality Settings drop-down list.

   - In the printer software, click Print & Scan and then click Set Preferences to access the print properties.

3. Check the estimated ink levels to determine if the cartridges are low on ink. For more information, see Check the estimated ink levels on page 44. If the ink cartridges are low on ink consider replacing them.

   For more information, see Check the estimated ink levels on page 44. If the ink cartridges are low on ink consider replacing them.

4. Align the cartridges.

To align the cartridges from the printer software

NOTE: Aligning the cartridges ensures the high-quality output. The HP All-in-One prompts you to align the cartridges every time you install a new cartridge. If you remove and reinstall the same ink cartridge, the HP All-in-One will not prompt you to align the ink cartridges. The HP All-in-One remembers the alignment values for that ink cartridge, so you do not need to realign the ink cartridges.

a. Load letter or A4 unused plain white paper into the paper tray.

b. Depending on your operating system, do one of the following to open the printer software:

   - Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer's name.

   - Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All Programs, click HP, click HP ENVY 5530 series, and then click HP ENVY 5530 series.

c. In the printer software, click Print & Scan, and then click Maintain Your Printer to access the Printer Toolbox.

e. Load the cartridge alignment sheet print side down on the right front corner of the scanner glass.

f. Follow the instructions on the printer display to align the cartridges. Recycle or discard the cartridge alignment sheet.

To align the cartridges from the printer display

a. From the Home screen on the printer display, select Tools.

   **NOTE:** If you do not see the Home screen, touch the Home button.

b. From the Tools menu on the printer display, select Align Printer. Follow the on-screen instructions.

5. Print a diagnostics page if the cartridges are not low on ink.

To print a diagnostics page from the printer software

a. Load letter or A4 unused plain white paper into the paper tray.

b. Depending on your operating system, do one of the following to open the printer software:

   - **Windows 8:** On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer’s name.

   - **Windows 7, Windows Vista,** and **Windows XP:** From the computer desktop, click Start, select All Programs, click HP, click HP ENVY 5530 series, and then click HP ENVY 5530 series.

c. In the printer software, click Print & Scan, and then click Maintain Your Printer to access the printer toolbox.

d. Click Print Diagnostic Information on the Device Reports tab to print a diagnostics page. Review the blue, magenta, yellow, and black boxes on the diagnostics page. If you are seeing streaks in the color and black boxes, or no ink in portions of the boxes, then automatically clean the cartridges.
To print a diagnostics page from the printer display

a. From the Home screen on the printer display, select Tools.

   NOTE: If you do not see the Home screen, press the Back button until you can see it.

b. From the Tools menu on the printer display, select Print Quality Report. Follow the on-screen instructions.

6. Clean the ink cartridges automatically, if the diagnostic page shows steaks or missing portions of the color and black boxes.

To clean the cartridges from the printer software

a. Load letter or A4 unused plain white paper into the paper tray.

b. Depending on your operating system, do one of the following to open the printer software:
   
   ● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and then click the icon with the printer’s name.
   
   ● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All Programs, click HP, click HP ENVY 5530 series, and then click HP ENVY 5530 series.

c. In the printer software, click Print & Scan and then click Maintain Your Printer to access the Printer Toolbox.

d. Click Clean Ink Cartridges on the Device Services tab. Follow the on-screen instructions.

To clean the cartridges from the printer display

a. From the Home screen on the printer display, select Tools.

   NOTE: If you do not see the Home screen, press the Back button until you can see it.

b. From the Tools menu on the printer display, select Clean Printhead. Follow the on-screen instructions.

   If the above solutions do not resolve the problem, click here for more online troubleshooting.
Ink cartridge problem

First try removing and reinserting the ink cartridges. Make sure the cartridges are in the correct slots. If this does not work, clean the cartridge contacts. If your problem is still not resolved, see Replace the cartridges on page 46 for more information.

To clean cartridge contacts

⚠️ CAUTION: The cleaning procedure should take only a few minutes. Make sure that the ink cartridges are reinstalled in the product as soon as possible. It is not recommended to leave the ink cartridges outside of the product longer than 30 minutes. This could result in damage to the ink cartridges.

1. Check that power is on.
2. Open the cartridge access door.

Wait for the print carriage to move to the ink label part of the product.

3. Remove the cartridge indicated in the error message.

4. Hold the ink cartridge by its sides with the bottom pointing up and locate the electrical contacts on the ink cartridge. The electrical contacts are the small gold-colored dots on the ink cartridge.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Electrical contacts</td>
</tr>
</tbody>
</table>
5. Wipe only the contacts with a damp lint-free cloth.

⚠️ **CAUTION:** Be careful to touch only the contacts, and do not smear any of the ink or other debris elsewhere on the cartridge.

6. On the inside of the printer, locate the contacts in the print carriage. The contacts look like a set of gold-colored bumps positioned to meet the contacts on the ink cartridge.

7. Use a dry swab or lint-free cloth to wipe the contacts.

8. Reinstall the ink cartridge.

9. Close the access door, and check if the error message has gone away.

10. If you still receive the error message, turn the product off, and then on again.

**NOTE:** If one ink cartridge is causing problems, you can remove it and use the single-cartridge mode to operate the HP ENVY 5530 series with only one cartridge.

[Click here to go online for more information.](#)
Unable to print

If you are having trouble printing, you can download the HP Print and Scan Doctor, which can troubleshoot this issue for you automatically. To get the utility, click the appropriate link:

**NOTE:** The HP Print and Scan Doctor may not be available in all languages.

[Take me to the HP Print and Scan Doctor download page.]

Resolve print issues

**NOTE:** Make sure that the printer is turned on and that there is paper in the tray. If you are still unable to print, try the following in order:

1. Check for error messages from the printer display and resolve them by following the onscreen instructions.

2. If your computer is connected to the printer with a USB cable, disconnect and reconnect the USB cable. If your computer is connected to the printer with a wireless connection, confirm that the connection is working.

3. Verify that the printer is not paused or offline.

To verify that the printer is not paused or offline

**a.** Depending on your operating system, do one of the following:

- **Windows 8:** Point to or tap the upper-right corner of the screen to open the Charms bar, click the **Settings** icon, click or tap **Control Panel**, and then click or tap **View devices and printers**.

- **Windows 7:** From the Windows **Start** menu, click **Devices and Printers**.

- **Windows Vista:** From the Windows **Start** menu, click **Control Panel**, and then click **Printers**.

- **Windows XP:** From the Windows **Start** menu, click **Control Panel**, and then click **Printers and Faxes**.

**b.** Either double-click the icon for your printer or right-click the icon for your printer and select **See what’s printing** to open the print queue.

**c.** On the **Printer** menu, make sure there are no check marks next to **Pause Printing** or **Use Printer Offline**.

**d.** If you made any changes, try to print again.

4. Verify that the printer is set as the default printer.

To verify that the printer is set as the default printer

**a.** Depending upon your operating system, do one of the following:

- **Windows 8:** Point to or tap the upper-right corner of the screen to open the Charms bar, click the **Settings** icon, click or tap **Control Panel**, and then click or tap **View devices and printers**.

- **Windows 7:** From the Windows **Start** menu, click **Devices and Printers**.

- **Windows XP:** From the Windows **Start** menu, click **Control Panel**, and then click **Printers and Faxes**.
• **Windows Vista**: From the Windows **Start** menu, click **Control Panel**, and then click **Printers**.

• **Windows XP**: From the Windows **Start** menu, click **Control Panel**, and then click **Printers and Faxes**.

b. Make sure the correct printer is set as the default printer.

   The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select **Set as Default Printer**.

d. Try using your printer again.

5. Restart the print spooler.

**To restart the print spooler**

   a. Depending upon your operating system, do one of the following:

**Windows 8**

   i. Point to or tap the upper-right corner of the screen to open the Charms bar, and then click the **Settings** icon.

   ii. Click or tap **Control Panel**, and then click or tap **System and Security**.

   iii. Click or tap **Administrative Tools**, and then double-click or double-tap **Services**.

   iv. Right-click or touch and hold **Print Spooler**, and then click **Properties**.

   v. On the **General** tab, next to **Startup type**, make sure that **Automatic** is selected.

   vi. If the service is not already running, under **Service status**, click or tap **Start**, and then click or tap **OK**.

**Windows 7**

   i. From the Windows **Start** menu, click **Control Panel**, **System and Security**, and then **Administrative Tools**.

   ii. Double-click **Services**.

   iii. Right-click the **Print Spooler**, and then click **Properties**.

   iv. On the **General** tab, next to **Startup type**, make sure that **Automatic** is selected.

   v. If the service is not already running, under **Service status**, click **Start**, and then click **OK**.

**Windows Vista**

   i. From the Windows **Start** menu, click **Control Panel**, **System and Maintenance**, **Administrative Tools**.

   ii. Double-click **Services**.

   iii. Right-click the **Print Spooler service**, and then click **Properties**.
iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click OK.

**Windows XP**

i. From the Windows Start menu, right click My Computer.

ii. Click Manage, and then click Services and Applications.

iii. Double-click Services, and then select Print Spooler.

iv. Right-click Print Spooler, and click Restart to restart the service.

b. Make sure the correct printer is set as the default printer. The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as Default Printer.

d. Try using your printer again.

6. Restart the computer.

7. Clear the print queue.

**To clear the print queue**

a. Depending upon your operating system, do one of the following:

   - **Windows 8**: Point to or tap the upper-right corner of the screen to open the Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View devices and printers.

   - **Windows 7**: From the Windows Start menu, click Devices and Printers.

   - **Windows Vista**: From the Windows Start menu, click Control Panel, and then click Printers.

   - **Windows XP**: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Double-click the icon for your printer to open the print queue.

c. On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to confirm.

d. If there are still documents in the queue, restart the computer and try printing again after the computer has restarted.

e. Check the print queue again to make sure it is clear, and then try to print again.

**To check the power connection and reset the printer**

1. Make sure the power cord is firmly connected to the printer.
1. Power connection to the printer

2. Connection to a power outlet

2. Look inside the printer and check for a green light indicating the printer is receiving electrical power. If it is not lit, make sure the cord is fully plugged into the printer, or connect to another power outlet.

3. Look at the On button located on the printer. If it is not lit, the printer is turned off. Press the On button to turn on the printer.

   **NOTE:** If the printer is not receiving electrical power, connect it to another power outlet.

4. With the printer turned on, disconnect the power cord from the side of the printer under the cartridge access door.

5. Unplug the power cord from the wall outlet.

6. Wait at least 15 seconds.

7. Plug the power cord back into the wall outlet.

8. Reconnect the power cord to the side of the printer under the cartridge access door.

9. If the printer does not turn on by itself, press the On button to turn on the printer.

10. Try using the printer again.

   If the above solutions do not resolve the problem, [click here for more online troubleshooting](#).
Solve print problem

Make sure that the printer is turned on and that there is paper in the paper tray. If you are still unable to print, HP printer software for Windows provides tools that can help solve many common “Unable to Print” issues.

To access the software on Windows, click the Start menu on your computer, then select All Programs, and then click HP. Under HP ENVY 5530 e-All-in-One series, click HP ENVY 5530 e-All-in-One series, click the Help button, and then double-click HP Print and Scan Doctor.

Click here to go online for more information.

If print quality is not acceptable, try the following to improve print quality:

- Use the printer status and print quality reports to diagnose printer and print quality issues. From the Home screen, touch the Settings icon, and then touch Tools. Touch Printer Status Report or Print Quality Report. Click here to go online for more information

- If printouts show misaligned colors or lines, try aligning the printer. See Improve print quality on page 70 for more information.

- If there are ink smears on the printouts, try clearing the ink smears. See Clean ink smear on page 69 for more information.
Solve copy and scan problem

HP provides a Scan Diagnostic Utility (Windows only) that can help solve many common "Unable to scan" issues. From the Start menu on your computer, click All Programs, and then click HP. Under HP ENVY 5530 e-All-in-One series, click HP ENVY 5530 e-All-in-One series, click the Help button, and then double-click HP Print and Scan Doctor.

Learn more about how to solve scan issues. Click here to go online for more information.

Learn how to solve copy issues. Click here to go online for more information.
Solve networking problem

Check the network configuration or print the wireless test report to assist in diagnosing network connection issues.

To check network configuration or print wireless test report

1. From the Home screen, touch the Wireless icon, and then touch Settings.
2. Touch the down arrow to scroll through options. Touch Display Network Configuration or Print Wireless Test Report.

Click the links below to find more online information to solve networking issues.

- Learn more about wireless printing. [Click here to go online for more information.]
- Learn how to find your network security settings. [Click here to go online for more information.]
- Learn about the HP Print and Scan Doctor (Windows only) and other troubleshooting tips. [Click here to go online for more information.]
- Learn how to work with your firewall and anti-virus programs during printer setup. [Click here to go online for more information.]
Cartridge errors (Windows software)

- Cartridge supply upgrade
- Check cartridge access door
- Older generation cartridges
- Printer failure
- Ink cartridge problem

Cartridge supply upgrade

If the supply upgrade is not successful, try getting your printer to recognize the supply upgrade cartridge.

To get the printer to recognize the supply upgrade cartridge:

1. Remove the supply upgrade cartridge.
2. Insert the original cartridge in the carriage.
3. Close the cartridge access door, then wait until the carriage stops moving.
4. Remove the original cartridge, then replace with the supply upgrade cartridge.
5. Close the cartridge access door, then wait until the carriage stops moving.

If you still receive a supply upgrade problem error message, contact HP support for help.

Click here to go online for more information.

Check cartridge access door

The cartridge access door should be closed for printing.

Click here to go online for more information.
Older generation cartridges

You will need to use a newer version of this cartridge. In most cases you can identify a newer version of the cartridge by looking at the exterior of the cartridge package and finding the Warranty Ends date.

If it says ‘v1’ several spaces to the right of the date, then the cartridge is the updated newer version. If it is an older generation cartridge, contact HP support for help or replacement.

Click here to go online for more information.

Printer failure

Resolve printer failure.

▲ Turn the printer off, then on. If that does not resolve the problem, contact HP.

Please contact HP support for help.

Ink cartridge problem

The ink cartridge is not compatible with your printer. This error can occur if you install an HP Instant Ink cartridge into a printer that has not been enrolled in the HP Instant Ink program. It can also occur if the HP Instant Ink cartridge was previously used in a different printer enrolled in the HP Instant Ink program.

Visit the HP Instant Ink program website for more information.
HP support

- Register printer
- Support process
- HP support by phone
- Additional warranty options

Register printer

By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and product support alerts. If you did not register your printer while installing the software, you can register now at http://www.register.hp.com.

Support process

If you have a problem, follow these steps:

1. Check the documentation that came with the printer.
2. Visit the HP online support website at www.hp.com/support.
   
   HP online support is available to all HP customers. It is the fastest source for up-to-date product information and expert assistance, and includes the following features:
   
   - Fast access to qualified online support specialists
   - Software and driver updates for the printer
   - Valuable troubleshooting information for common problems
   - Proactive printer updates, support alerts, and HP newsgrams that are available when you register the printer
3. Call HP support.
   
   Support options and availability vary by printer, country/region, and language.

HP support by phone

Phone support options and availability vary by product, country/region, and language.

This section contains the following topics:

- Phone support period
- Placing a call
- Support phone numbers
- After the phone support period
Phone support period

One year of phone support is available in North America, Asia Pacific, and Latin America (including Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to www.hp.com/support. Standard phone company charges apply.

Placing a call

Call HP support while you are in front of the computer and the printer. Be prepared to provide the following information:

- Product name (Located on the printer, such as HP ENVY 5530)
- Product number (located inside the cartridge access door)
- Serial number (located on the back or bottom of the printer)
- Messages that appear when the situation occurs
- Answers to these questions:
  - Has this situation happened before?
  - Can you recreate it?
  - Did you add any new hardware or software to your computer at about the time that this situation began?
  - Did anything else occur prior to this situation (such as a thunderstorm, the printer was moved, etc.)?

Support phone numbers

For the most current HP list of telephone support numbers and call costs information, see www.hp.com/support.

After the phone support period

After the phone support period, help is available from HP at an additional cost. Help may also be available at the HP online support website: www.hp.com/support. Contact your HP dealer or call the support phone number for your country/region to learn more about support options.

Additional warranty options

Extended service plans are available for the HP ENVY 5530 series at additional costs. Go to www.hp.com/support, select your country/region and language, then explore the services and warranty area for information about the extended service plans.
The technical specifications and international regulatory information for the HP ENVY 5530 series are provided in this section.

For additional specifications, see the printed documentation that came with the HP ENVY 5530 series.

This section contains the following topics:

- Hewlett-Packard Company notices
- Specifications
- Environmental product stewardship program
- Regulatory notices
Specifications

Technical specifications for the HP ENVY 5530 series are provided in this section. For more product specifications, see the Product Data Sheet at www.hp.com/support.

- System requirements
- Environmental specifications
- Print specifications
- Scan specifications
- Copy specifications
- Cartridge yield
- Print resolution

System requirements

Software and system requirements are located in the Readme file.

For information about future operating system releases and support, visit the HP online support website at www.hp.com/support.

Environmental specifications

- Recommended operating temperature range: 15°C to 32°C (59°F to 90°F)
- Allowable operating temperature range: 5°C to 40°C (41°F to 104°F)
- Humidity: 20% to 80% RH non-condensing (recommended); 25°C maximum dewpoint
- Non-operating (Storage) temperature range: –40°C to 60°C (-40°F to 140°F)
- In the presence of high electromagnetic fields, it is possible the output from the HP ENVY 5530 series may be slightly distorted.
- HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected noise due to potential high electromagnetic fields.

Print specifications

- Print speeds vary according to the complexity of the document.
- Method: drop-on-demand thermal inkjet
- Language: PCL3 GUI

Scan specifications

- Optical Resolution: up to 1200 dpi
- Hardware Resolution: up to 1200 x 1200 dpi
- Enhanced Resolution: up to 1200 x 1200 dpi
- Bitdepth: 24-bit color, 8-bit grayscale (256 levels of gray)
- Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)
- Supported File Types: BMP, JPEG, PNG, TIFF, PDF
- Twain Version: 1.9

**Copy specifications**

- Digital image processing
- Maximum number of copies varies by model.
- Copy speeds vary according to the complexity of the document and model.

**Cartridge yield**

Visit [www.hp.com/go/learnaboutsupplies](http://www.hp.com/go/learnaboutsupplies) for more information on estimated cartridge yields.

**Print resolution**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Color Input/Black Render</th>
<th>Output (Black/Color)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft mode</td>
<td>300x300dpi</td>
<td>Automatic</td>
</tr>
<tr>
<td>Normal mode</td>
<td>600x300dpi</td>
<td>Automatic</td>
</tr>
<tr>
<td>Plain-Best mode</td>
<td>600x600dpi</td>
<td>Automatic</td>
</tr>
<tr>
<td>Photo-Best mode</td>
<td>600x600dpi</td>
<td>Automatic</td>
</tr>
<tr>
<td>Max DPI mode</td>
<td>1200x1200dpi</td>
<td>Automatic (Black), 4800x1200 optimized dpi (Color)</td>
</tr>
</tbody>
</table>
Environmental product stewardship program

Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design for recycling has been incorporated into this product. The number of materials has been kept to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and other connections are easy to locate, access, and remove using common tools. High priority parts are designed for efficient disassembly and repair.

For more information, visit HP’s Commitment to the Environment website at:


This section contains the following topics:

- Eco-Tips
- Paper use
- Plastics
- Material safety data sheets
- Recycling program
- HP inkjet supplies recycling program
- Power consumption
- Disposal of waste equipment by users
- Chemical substances
- Toxic and hazardous substance table (China)
- Restriction of hazardous substance (Ukraine)
- Restriction of hazardous substance (India)
- Sleep mode

Eco-Tips

HP is committed to helping customers reduce their environmental footprint. Please visit the HP Environmental Programs and Initiatives website for more information on HP’s environmental initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

Paper use

This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify plastics for recycling purposes at the end of product life.
Material safety data sheets

Material safety data sheets (MSDS) can be obtained from the HP website at:

www.hp.com/go/msds

Recycling program

HP offers an increasing number of product return and recycling programs in many countries/regions, and partners with some of the largest electronic recycling centers throughout the world. HP conserves resources by reselling some of its most popular products. For more information regarding recycling of HP products, please visit:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more information, go to the following website:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Power consumption

Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment. The following mark will appear on ENERGY STAR qualified imaging products:

![ENERGY STAR](https://example.com/energy-star.png)

Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/go/energystar

Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste. Instead, you should protect human health and the environment by handing over your waste equipment to a designated collection point for the recycling of waste electrical and electronic equipment. For more information, please contact your household waste disposal service, or go to http://www.hp.com/recycle.
Chemical substances

HP is committed to providing our customers with information about the chemical substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/reach.

Toxic and hazardous substance table (China)

Restriction of hazardous substance (Ukraine)

Restriction of hazardous substance (India)

Sleep mode

- Power usage is reduced while in the Sleep mode.
- After initial setup of printer, the printer will enter the Sleep mode after five minutes of inactivity.
- The time to the Sleep mode can be changed from the control panel.
To set the Sleep mode time

1. From the Home screen, touch the Settings icon.

2. Touch Preferences.

3. Touch the down arrow to scroll through the options, and then touch Sleep Mode.

4. Touch After 5 minutes or After 10 minutes, or After 15 minutes.
Regulatory notices

The HP ENVY 5530 series meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

- Regulatory model identification number
- FCC statement
- VCCI (Class B) compliance statement for users in Japan
- Notice to users in Japan about the power cord
- Notice to users in Korea
- Notice to users in Germany
- Noise emission statement for Germany
- European Union Regulatory Notice
- Declaration of conformity
- Regulatory wireless statements

Regulatory model identification number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory Model Number for your product is SNPRH-1202. This regulatory number should not be confused with the marketing name (HP ENVY 5530 e-All-in-One series, etc.) or product numbers (A9J40 to A9J49, etc.).
FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified that the following notice be brought to the attention of users of this product.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

For further information, contact:
Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501

Modifications (part 15.21)

The FCC requires the user to be notified that any changes or modifications made to this device that are not expressly approved by HP may void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

VCCI (Class B) compliance statement for users in Japan

この装置は、クラスB情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この装置がラジオやテレビジョン受信機に近接して使用されると、受信障害を引き起こすことがあります。取扱説明書に従って正しい取り扱いをして下さい。

VCCI-B

Notice to users in Japan about the power cord

製品には、同梱された電源コードをお使い下さい。
同梱された電源コードは、他の製品では使用出来ません。
Notice to users in Korea

Notice to users in Germany

Noise emission statement for Germany

European Union Regulatory Notice

Products bearing the CE marking comply with the following EU Directives:

- Low Voltage Directive 2006/95/EC
- EMC Directive 2004/108/EC
- Ecodesign Directive 2009/125/EC, where applicable

CE compliance of this product is valid only if powered with the correct CE-marked AC adapter provided by HP.

If this product has telecommunications functionality, it also complies with the essential requirements of the following EU Directive:

- R&TTE Directive 1999/5/EC

Compliance with these directives implies conformity to applicable harmonized European standards (European Norms) that are listed in the EU Declaration of Conformity issued by HP for this product or product family and available (in English only) either within the product documentation or at the following website: [www.hp.com/go/certificates](http://www.hp.com/go/certificates) (type the product number in the search field).

The compliance is indicated by one of the following conformity markings placed on the product:
For non-telecommunications products and for EU harmonized telecommunications products, such as Bluetooth® within power class below 10mW.

For EU non-harmonized telecommunications products (If applicable, a 4-digit notified body number is inserted between CE and !).

Please refer to the regulatory label provided on the product.

The telecommunications functionality of this product may be used in the following EU and EFTA countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden, Switzerland, and United Kingdom.

The telephone connector (not available for all products) is intended for connection to analogue telephone networks.

**Products with wireless LAN devices**

- Some countries may have specific obligations or special requirements about the operation of Wireless LAN networks such as indoor use only or restrictions of the channels available. Please make sure that the country settings of the wireless network are correct.

**France**

- For 2.4-GHz Wireless LAN operation of this product, certain restrictions apply: This product may be used indoors for the entire 2400-MHz to 2483.5-MHz frequency band (channels 1 to 13). For outdoor use, only the 2400-MHz to 2454-MHz frequency band (channels 1 to 7) may be used. For the latest requirements, see [www.arcep.fr](http://www.arcep.fr).

The point of contact for regulatory matters is:

Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, GERMANY
Declaration of conformity

DECLARATION OF CONFORMANCE
according to ISO/IEC 17050-1 and EN 17050-1

Dc# : SNPR-1202-R1

Supplier's Name: Hewlett-Packard Company
Supplier's Address: 20, Jia Fang Road Wiganqiao Free Trade Zone Pudong, Shanghai,

declares that the product

Product Name and Model: HP Envy 5530 eAll-in-One Printer series
HP Deskjet Ink Advantage 4510 eAll-in-One Printer series

Regulatory Model Number: SNPR-1202
Radio Models: SDG06-1292

Product Options: All

conforms to the following Product Specifications and Regulations:

EMC:
- CISPR 22:2008 Class B
- EN 55022:2010 Class B
- EN 55024:2010
- EN 61000-3-3:2008
- FCC CFR 47 Part 15 Class B
- ICES-003, Issue 4 Class B

Safety:
- EN 62479:2010

Telecoms:
- EN 300 328 V1.7.1
- EN 301 489-1 V1.8.1
- EN 301 489-17 V2.1.1
- EN 62311:2008

Energy Use:
- Regulation (EC) No. 1275/2008
- ENERGY STAR® Qualified Imaging Equipment Operational Mode (OM) Test Procedures

RoHS:
- EN 50581:2012


This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Additional Information:
1) This product is assigned a Regulatory Model Number which stays with the regulatory reports of the design. The Regulatory Model Number is the main product identifier in the regulatory documentation and test reports, this number should not be confused with the marketing name or the product numbers.

Shen Yangbo
K5 Product Hardware Quality Engineering Manager

Local contact for regulatory topics only:
Eh: Hewlett-Packard GmbH, H1Q1RE, Herrenberger Straße 140, 71034 Bochum, Germany
U.S.: Hewlett-Packard, 3900 Hanover St, Palo Alto 94304, U.S.A. 650-857-1801

Regulatory wireless statements

This section contains the following regulatory information pertaining to wireless products:

- Exposure to radio frequency radiation
- Notice to users in Brazil
- Notice to users in Canada
- Notice to users in Mexico
- Notice to users in Taiwan
- Wireless notice to users in Japan
Exposure to radio frequency radiation

**Exposure to radio frequency radiation**

**Caution**  The radiated output power of this device is far below the FCC radio frequency exposure limits. Nevertheless, the device shall be used in such a manner that the potential for human contact during normal operation is minimized. This product and any attached external antenna, if supported, shall be placed in such a manner to minimize the potential for human contact during normal operation. In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human proximity to the antenna shall not be less than 20 cm (8 inches) during normal operation.

Notice to users in Brazil

**Aviso aos usuários no Brasil**

Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a sistemas operando em caráter primário. (Res. ANATEL 282/2001).
Notice to users in Canada

**Notice to users in Canada/Note à l’attention des utilisateurs canadiens**

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

**WARNING!** Exposure to Radio Frequency Radiation The radiated output power of this device is below the Industry Canada radio frequency exposure limits. Nevertheless, the device should be used in such a manner that the potential for human contact is minimized during normal operation.

To avoid the possibility of exceeding the Industry Canada radio frequency exposure limits, human proximity to the antennas should not be less than 20 cm (8 inches).

Conformément au Règlement d’Industrie Canada, cet émetteur radioélectrique ne peut fonctionner qu’avec une antenne d’un type et d’un gain maximum (ou moindre) approuvé par Industrie Canada. Afin de réduire le brouillage radioélectrique potentiel pour d’autres utilisateurs, le type d’antenne et son gain doivent être choisis de manière à ce que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas celle nécessaire à une communication réussie.

Cet appareil est conforme aux normes RSS exemptes de licence d’Industrie Canada. Son fonctionnement dépend des deux conditions suivantes : (1) cet appareil ne doit pas provoquer d’interférences nuisibles et (2) doit accepter toutes interférences reçues, y compris des interférences pouvant provoquer un fonctionnement non souhaité de l’appareil.

**AVERTISSEMENT** relatif à l’exposition aux radiofréquences. La puissance de rayonnement de cet appareil se trouve sous les limites d’exposition de radiofréquences d’Industrie Canada. Néanmoins, cet appareil doit être utilisé de telle sorte qu’il soit mis en contact le moins possible avec le corps humain.

Afin d’éviter le dépassement éventuel des limites d’exposition aux radiofréquences d’Industrie Canada, il est recommandé de maintenir une distance de plus de 20 cm entre les antennes et l’utilisateur.

Notice to users in Mexico

**Aviso para los usuarios de México**

La operación de este equipo está sujeta a las siguientes dos condiciones: (1) es posible que este equipo o dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe aceptar cualquier interferencia, incluyendo la que pueda causar su operación no deseada.

Para saber el modelo de la tarjeta inalámbrica utilizada, revise la etiqueta regulatoria de la impresora.
Notice to users in Taiwan

低功率電波輻射性電機管理辦法
第十二條
經型式認證合格之低功率射頻電機，非經許可，公司、商號或使用者均不得擅自變更頻
率、加大功率或變更設計之特性及功能。

第十四條
低功率射頻電機之使用不得影響飛航安全及干擾合法通信；經發現有干擾現象時，應立
即停用，並改善至無干擾時方得繼續使用。

無線電設施，相應電信法規定檔案之無線電設施。低功率射頻電機須忍受合法通信或
工業、科學及醫療用電波輻射性電機設備之干擾。

Wireless notice to users in Japan

この機器は技術基準適合証明又は工事設計認証を受けた無線設備を搭載しています。
Index

A
after the support period 85

B
buttons, control panel 6

C
control panel
  buttons 6
  features 6
copy
  specifications 90
customer support
  warranty 85

E
environment
  Environmental product stewardship program 91
  environmental specifications 89

I
interface card 54, 55

N
network
  interface card 54, 55

P
paper
  recommended types 22
phone support 84
phone support period
  period for support 85
print
  specifications 89

R
recycle
  ink cartridges 92
regulatory notices 95
  regulatory model identification number 95
  wireless statements 99

S
scan
  scan specifications 89
support process 84
system requirements 89

T
technical information
  copy specifications 90
  environmental specifications 89
  print specifications 89
  scan specifications 89
  system requirements 89

W
warranty 85